
Любой пользователь, имеющий доступ в Интернет, иной раз задается
вопросом собственной безопасности при путешествиях по Сети.
Периодически появляющиеся сообщения о новых вирусах или хакерских
атаках только усиливают чувство тревоги. А поскольку подавляющее
большинство общается со Всемирной паутиной с помощью браузера,
то в первую очередь встает вопрос именно о его защищенности.

ÅÂÁÓÔ‡ÒÌ˚È 
ÒÂÙËÌ„

»
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Вот о средствах безопасности, имею-

щихся в наиболее популярных браузе-

рах, мы и поговорим. Выбор описывае-

мых браузеров, как и операционных систем,

для которых они предназначены, был обус-

ловлен данными статистики от HotLOG.ru. Как

видите, самым популярным браузером в тече-

ние продолжительного времени вполне заслу-

женно остается Internet Explorer. А вот по-

следние версии Netscape популярностью на

просторах России пока не пользуются. Люди

предпочитают более старую, но проверенную

временем четвертую версию. Поэтому именно

она включена в этот обзор. 

Ñ‡ÌÌ˚Â ÒÚ‡ÚËÒÚËÍË HotLOG.ru Á‡ ÔÂ‚ÓÂ ÔÓÎÛ„Ó‰ËÂ 2002 „Ó‰‡ 
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SSL Ë ÒÂÚËÙËÍ‡Ú˚
Secure Sockets Layer (с англ. — «безопасный

уровень соединителей») — протокол, пред-

назначенный для защищенной передачи дан-

ных. Вспомните, как начинается адрес, кото-

рый вы набираете в строке вашего браузера?

Наверняка в 99% случаев это будет «http», а

значит, работая с WWW, вы пользуетесь про-

токолом пересылки гипертекста (Hypertext

Transfer Protocol). Как это ни печально, обыч-

ный протокол HTTP не гарантирует должного

уровня конфиденциальности, так как вся ин-

формация передается в незашифрованном

виде по открытым каналам при недостаточ-

ном уровне аутентификации (авторизован-

ный вход в какую-либо систему). Пользова-

тель вводит логин и пароль, которые затем

передаются web-серверу в незашифрован-

ном виде. Это во-первых, а во-вторых, прото-

кол HTTP не позволяет идентифицировать

объекты, участвующие в обмене информаци-

ей. Говоря простым языком, мы не можем

быть уверены в том, что объекты выдают се-

бя за тех, кем они являются на самом деле, и

что по пути злоумышленниками не будет пе-

рехвачена никакая информация, будь то PIN-

код кредитной карточки или пароль почто-

вого ящика. Протокол HTTPS, аналогичный

HTTP, но использующий технологию SSL, поз-

воляет решить данные проблемы. 

Основой HTTPS являются сертификаты

(своеобразный «паспорт») и криптозащита

(шифрование). При инициализации обмена

информацией браузер и сервер обменивают-

ся сертификатами, тем самым однозначно

идентифицируя себя. Дальнейшее взаимо-

действие осуществляется по зашифрованно-

му каналу. В итоге SSL теоретически может

обеспечить полную защиту любого соедине-

ния в Интернете. Но только теоретически. 

На практике же все зависит от безошибоч-

ной реализации этой технологии в конкрет-

ном браузере. Обнаруженные уязвимости

разработчики стараются устранить очеред-

ной «заплаткой», или сервис-паком. Выход

сервис-паков для ПО, использующего SSL,

сейчас вещь нередкая, что говорит о недо-

статочной степени совершенства реализации

SSL-протокола во многих популярных ныне

программах.

Теперь о главном — о реализации систем

защиты в различных браузерах. 

Mozilla 1.0

Браузер, который чрезвычайно долго не мог

избавиться от нуля в порядковом номере

версии, наконец дорос до финального релиза

и теперь существует как в версиях для Linux,

так и для Windows. Пункты меню одинаковы

для обеих версий, и добраться до них можно

следующим образом: «Edit -> Preferences ->

Privacy & Security». Нас интересуют следую-

щие из них.

3 «Passwords» — менеджер паролей автома-

тически запоминает и при необходимости

сам вводит имена и пароли к указанным в

списке сайтам.

3 «Master Passwords» — защищает личную

информацию (пароли, доступ к сертифика-

там, работу со смарт-картами и др.). Если

посторонний человек пользуется вашим

браузером, то, не зная мастер-пароля, он не

сможет воспользоваться вашими сертифи-

катами и сохраненными паролями. То есть,

злоумышленник, работая с финансовыми

или корпоративными web-сайтами, не смо-

жет выдать себя за вас и осуществить ка-

кие-либо операции от вашего имени. При

вводе мастер-пароля можно проверить

устойчивость к подбору комбинаций. Эта

функция интересна и сама по себе уже мо-

жет гарантировать достаточно высокую

степень безопасности.

3 «SSL» — настройка работы по протоколу

SSL (выбор версий, методов шифрования).

3 «Certificates» — управление сертификата-

ми и устройствами защиты. В этом пункте

можно добавлять или удалять сертификаты

сайтов и свои собственные, а также уже

имеющиеся в базе браузера сертификаты

известных компаний и корпораций и про-

сматривать информацию о них (например,

срок действия). Настройки этого пункта »

»
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1 çÂÓ·ıÓ‰ËÏ˚È ÏËÌËÏÛÏ Á‡˘ËÚ˚ ‚ Opera 6.04

7 ç‡ÒÚÓÈÍË ·ÂÁÓÔ‡ÒÌÓÒÚË
‚ Mozilla 1.0 («Master
passwords»)

1 ç‡ÒÚÓÈÍË ·ÂÁÓÔ‡ÒÌÓÒÚË ‚ Netscape 4.75, ÔÛÌÍÚ «Passwords»



просты и интуитивно понятны, как, впрочем,

и в других рассматриваемых браузерах. 

3 «Validation» — проверка действительности

сертификатов и управление аннулирован-

ными (отозванными). В браузере предус-

мотрена автоматизация этого процесса —

опция «Online Certificate Status Protocol»

(OCSP), — что очень удобно. 

Разработчики этого браузера уделяют бе-

зопасности очень серьезное внимание, и,

возможно, в дальнейшем Mozilla приобретет

существенно большее число поклонников,

чем сейчас. 

Netscape Communicator 4.75

Этот браузер в последнее время всячески пы-

тается вновь завоевать утраченные позиции.

Вышла уже версия под номером 7, но в на-

шей стране наиболее популярной остается

все же старая добрая 4.75, проверенная го-

дами использования. С точки зрения безо-

пасности коренных отличий между ними не

существует, поэтому мы смело можем рас-

сматривать Netscape Communicator 4.75.

Итак, открываем настройки безопасности

(«Communicator -> Tools -> Security Info») и

видим следующие пункты.

3 «Security Info» — сообщает сведения о со-

стоянии текущего уровня безопасности при

работе с браузером (например, осуществ-

ляется ли шифрование трафика или нет). 

3 «Passwords» — назначение опции анало-

гично пункту «Master Passwords» в Mozilla. 

3 «Navigator» — настройка параметров рабо-

ты по протоколу SSL.

3 «Messenger» — непосредственно к брау-

зеру этот пункт отношения не имеет, это

настройки безопасности для интернет-

пейджера Instant Messenger.

3 «Java/Java Scripts» — управление серти-

фикатами и активизацией Java-апплетов и

скриптов.

3 «Certificates» — пункт управления сер-

тификатами, чье содержимое практиче-

ски полностью аналогично разделу «Ma-

nage Certificates» в одноименной опции

Mozilla.

3 «Cryptographic Modules» — управление

криптографическими модулями, использу-

емыми браузером (смарт-карты и другие). 

Настройки Netscape Communicator очень

похожи на имеющиеся в Mozilla, что неуди-

вительно, поскольку оба браузера построе-

ны на одном ядре. 

Opera 6.04

Все опции безопасности («File -> Preferences

-> Security») здесь сведены к необходимому

минимуму, умещаются в одном окошке, и их

характеристики мало отличаются от тех, что

существуют у «собратьев». Так, раздел «Pass-

word» фактически полностью аналогичен ма-

стер-паролю в Mozilla. Как уже говорилось,

средства безопасности в Opera оставляют

пользователю не слишком много возможно-

стей для настройки, поскольку ее сильными

сторонами являются скорость загрузки стра-

ниц и компактность. Именно этим свойствам

браузера и уделяют основное внимание раз-

работчики. Впрочем, не за горами выход

Opera 7, движок которого должен быть, по за-

явлениям создателей, полностью переписан.

Возможно, в новой версии мы увидим другие

средства безопасности.

Internet Explorer 6.0

В этом браузере с настройками безопасности,

сосредоточенными в меню «Tools -> Internet

Options... -> Security», дела обстоят поинте-

реснее: Microsoft, в отличие от других разра-

ботчиков ПО, ввела понятия Security Level

(«уровень безопасности») и Security Zones

(«зоны безопасности»). Таким образом, для

каждой зоны можно установить свой, персо-

нальный уровень безопасности. Всего имеет-

ся четыре зоны.

3 «Internet», куда входят все web-сайты, не

указанные в остальных зонах. В отличие от

других зон, добавлять выборочно отдельно

взятые сайты сюда нельзя.

3 «Local intranet», где устанавливаются на-

стройки безопасности для ресурсов ло-

кальной сети. Нажав кнопку «Sites...»,

можно выбрать, какие именно ресурсы

включать в эту зону: »

á‡ÔÎ‡ÚÍË ‰Îfl ÎË‰Â‡
ÇÓÍÛ„ ·‡ÛÁÂ‡ ÓÚ ÍÓÏÔ‡ÌËË Microsoft ÔÓ-

ÒÚÓflÌÌÓ ‚ÓÁÌËÍ‡ÎË Í‡ÍËÂ-ÌË·Û‰¸ ÒÎÛıË ËÎË

ÒÍ‡Ì‰‡Î˚. Ç ÔÂ‚Û˛ Ó˜ÂÂ‰¸ ˝ÚÓ ·˚ÎÓ Ò‚fl-

Á‡ÌÓ Ò ‚ÓÔÓÒ‡ÏË ·ÂÁÓÔ‡ÒÌÓÒÚË, ‡ Ú‡ÍÊÂ Ò

ÚÂÏ, ˜ÚÓ ·‡ÛÁÂ Ò Ò‡ÏÓ„Ó Ì‡˜‡Î‡ ‚ıÓ‰ËÎ ‚

ÒÓÒÚ‡‚ ÓÔÂ‡ˆËÓÌÌÓÈ ÒËÒÚÂÏ˚ Ë ËÁ·‡‚ËÚ¸-

Òfl ÓÚ ÌÂ„Ó ÎÂ„‡Î¸Ì˚ÏË ÏÂÚÓ‰‡ÏË ·˚ÎÓ

Ô‡ÍÚË˜ÂÒÍË ÌÂ‚ÓÁÏÓÊÌÓ. ä Í‡Ê‰ÓÈ ‚ÂÒË-

ÂÈ Internet Explorer ÔÓfl‚ÎflÎËÒ¸ ‰ÓÔÓÎÌÂÌËfl

Ë ËÒÔ‡‚ÎÂÌËfl, ÔËÁ‚‡ÌÌ˚Â ÔÓ‚˚ÒËÚ¸ ÛÓ-

‚ÂÌ¸ Â„Ó ·ÂÁÓÔ‡ÒÌÓÒÚË. çÂ ÒÚ‡Î ËÒÍÎ˛˜Â-

ÌËÂÏ Ë Internet Explorer 6. 9 ÒÂÌÚfl·fl

2002 „Ó‰‡ ÍÓÔÓ‡ˆËfl Microsoft ÓÙËˆË‡Î¸-

ÌÓ ‚˚ÔÛÒÚËÎ‡ ‰Îfl ÌÂ„Ó Ì‡·Ó ËÒÔ‡‚ÎÂÌËÈ

Service Pack 1 (Q326489), ÍÓÚÓ˚È Ì‡ıÓ-

‰ËÎÒfl Ì‡ ·ÂÚ‡-ÚÂÒÚËÓ‚‡ÌËË Ò Ì‡˜‡Î‡ Ë˛-

Îfl. ëÂ‰Ë ÔÓ˜Ëı ·˚ÎË ËÒÔ‡‚ÎÂÌ˚ Ó¯Ë·-

Í‡ Á‡„ÛÁÍË Ù‡ÈÎÓ‚ ÔÓ SSL-ÒÓÂ‰ËÌÂÌË˛

ÔË ÌÂÍ˝¯ËÓ‚‡ÌÌÓÏ ÒÓÂ‰ËÌÂÌËË (Q323308)

Ë Ó¯Ë·Í‡ NTLM ‡ÛÚÂÌÚËÙËÍ‡ˆËË ˜ÂÂÁ SSL

(Q325662).

SSL ÔÂ‰ÒÚ‡‚ÎflÂÚ ÒÓ·ÓÈ ÔÓÚÓÍÓÎ ‰Îfl Ó·-

ÏÂÌ‡ ËÌÙÓÏ‡ˆËÂÈ ‚ Á‡˘Ë˘ÂÌÌÓÏ ÂÊË-

ÏÂ, Ë Ì‡ ‰‡ÌÌ˚È ÏÓÏÂÌÚ ÒÛ˘ÂÒÚ‚Û˛Ú ‚Â-

ÒËË SSL 2 Ë SSL 3, ÏÂÊ‰Û ÍÓÚÓ˚ÏË Ò

ÔÓÎ¸ÁÓ‚‡ÚÂÎ¸ÒÍÓÈ ÚÓ˜ÍË ÁÂÌËfl ÌÂ ÒÎË¯-

ÍÓÏ ·ÓÎ¸¯‡fl ‡ÁÌËˆ‡. èÓÍ‡ ÌÂËÁ‚ÂÒÚÌÓ,

ÔÓfl‚flÚÒfl ÎË ‰Îfl Ò‡ÏÓ„Ó ÔÓÔÛÎflÌÓ„Ó ·‡Û-

ÁÂ‡ ÌÓ‚˚Â «Á‡ÔÎ‡ÚÍË», ÌÓ ÒÛ‰fl ÔÓ ÚÓÏÛ,

Í‡Í ‡ÒÚÂÚ ÔÓÔÛÎflÌÓÒÚ¸ Â„Ó ÍÓÌÍÛÂÌÚÓ‚,

‡Á‡·ÓÚ˜ËÍ‡Ï ËÁ Microsoft ÒÚÓËÚ ‚ÒÂ¸ÂÁ

ÔÓ·ÂÒÔÓÍÓËÚ¸Òfl Ó ÒÛ‰¸·Â Ò‚ÓÂ„Ó ‰ÂÚË˘‡.

Internet Explorer 6
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1 äÓÌÙË„ÛËÓ‚‡ÌËÂ ÁÓÌ˚ «Local intra-
net» ‚ IE 6.0

7 ç‡ÒÚÓÈÍË ·ÂÁÓÔ‡ÒÌÓÒÚË ‚ Internet Ex-
plorer 6.0 ‰ÓÒÚ‡ÚÓ˜ÌÓ Ó·¯ËÌ˚, Ë ÔÓÎ¸-
ÁÓ‚‡ÚÂÎ¸ ÏÓÊÂÚ Ò‡Ï ‚˚·‡Ú¸ ÚÓÚ ÛÓ-
‚ÂÌ¸, ÍÓÚÓ˚È Ò˜ËÚ‡ÂÚ ÔËÂÏÎÂÏ˚Ï

»



а) Include all local (intranet) sites not lis-

ted in other zones — все локальные сайты, не

указанные в других зонах. Это те сайты, в

имена которых не входят точки (например,

http://vasya, но не http://www.vasya.ru); 

б) Include all sites that bypass the proxy

server — все сайты, подключенные напрямую

к прокси-серверу.

в) Include all network paths (UNCs) — все

сетевые имена, такие как \\vasya\public\mu-

sic и прочие.

Также, нажав на «Advanced», вам дается

возможность добавить в эту зону необходи-

мые локальные web-ресурсы самостоятельно.

Чтобы добавить только поддерживающие

HTTPS, активизируйте галочку «Require server

verification (https:) for all sites in this zone»

3 «Trusted sites» — надежные web-ресурсы,

которым можно доверять. Все операции по

добавлению сайтов аналогичны тому, как

это происходит для зоны «Local intranet».

Microsoft настоятельно рекомендует добав-

лять сюда только сайты с поддержкой

HTTPS.

3 «Restricted sites» — ненадежные web-

ресурсы. Сюда заносятся сайты, содержи-

мое которых может быть опасным для ва-

шего компьютера. 

Уровней безопасности предусмотрено то-

же четыре, но, выбрав пункт меню «Custom

level...», можно изменить настройки по свое-

му вкусу. 

3 «High» — наивысший. Обеспечивает самый

безопасный серфинг. Но некоторые стра-

ницы могут отображаться некорректно:

отключены ActiveX, Java и другие небезо-

пасные элементы. Данный уровень пред-

назначен для работы с «Restricted sites»

3 «Medium» — средний. Обычный уровень

безопасности подходит для большинства

web-сайтов, поэтому он рекомендуется для

зоны «Internet».

3 «Medium-low» — пониженный. От среднего

уровня он отличается тем, что отключены

запросы на загрузку многих компонентов.

Рекомендуется для зоны «Local intranet».

3 «Low» — низкий. По причине крайне низ-

кой защищенности рекомендуется приме-

нять только для «Trusted sites».

Следует заметить, что, несмотря на много-

численные настройки, Internet Explorer за-

служил славу дружелюбного, но плохо защи-

щенного браузера. В нем неоднократно

обнаруживались «дыры», которые разработ-

чикам приходилось латать.

Вышеперечисленными пунктами наст-

ройки безопасности не исчерпываются.

На вкладке «Advanced» почти в самом

конце списка настроек (раздел «Security»)

находится управление SSL-протоколом:

проверка аннулированных сертификатов,

выбор используемых версий SSL и не-

которые другие пункты. А на вкладке

«Content» осуществляется управление

сертификатами («Certificates»), автомати-

ческим вводом паролей («Personal infor-

mation -> AutoComplete...») и персональ-

ными данными («Personal information ->

My Profile»). 

Стоит отметить, что любой сертификат

имеет определенный срок действия, по

истечении которого становится недей-

ствительным. За этим обязательно нужно

следить и вовремя аннулировать такие

сертификаты, хранящиеся в базе вашего

браузера.

Возможно, какие-либо пункты в IE

покажутся вам излишними. Но если ра-

зобраться в них и уделить время настрой-

ке, то удобная работа в WWW вам обеспе-

чена. По крайней мере, так нас заверяет

Microsoft...

Но не стоит забывать, что при всей схо-

жести настроек безопасности в браузерах

могут быть допущены ошибки в реализации

тех или иных методов защиты. С каким брау-

зером работать — дело вкуса, но в вопросах

безопасности ему доверять не приходится.

Давать какие-либо рекомендации довольно

сложно, поскольку если Internet Explorer

более корректно отображает подавляющее

большинство страниц, то с безопасностью у

него дела обстоят не слишком хорошо. От

себя скажу, что предпочитаю пользоваться

Internet Explorer за его «адекватное» пони-

мание HTML-кода. И Mozilla — за то, что

вопросам безопасности его разработчики

уделяют больше внимания, чем остальные.

Константин Николаенко
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1 ìÔ‡‚ÎÂÌËÂ Ô‡‡ÏÂÚ‡ÏË ÛÓ‚ÌÂÈ
·ÂÁÓÔ‡ÒÌÓÒÚË ‚ IE 6.0 («Custom level»)
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Mozilla 1.0

ê‡Á‡·ÓÚ˜ËÍ: Mozilla.org
http://mozilla.org 
ìÒÎÓ‚Ëfl ‡ÒÔÓÒÚ‡ÌÂÌËfl: freeware 
éÔÂ‡ˆËÓÌÌ‡fl ÒËÒÚÂÏ‡: Windows, Linux

Netscape Communicator 4.75

ê‡Á‡·ÓÚ˜ËÍ: Netscape Communications
Corporation
http://home.netscape.com
ìÒÎÓ‚Ëfl ‡ÒÔÓÒÚ‡ÌÂÌËfl: freeware 
éÔÂ‡ˆËÓÌÌ‡fl ÒËÒÚÂÏ‡: Windows, Linux

Opera 6.04

ê‡Á‡·ÓÚ˜ËÍ: Opera Software
www.opera.com
ìÒÎÓ‚Ëfl ‡ÒÔÓÒÚ‡ÌÂÌËfl: adware
éÔÂ‡ˆËÓÌÌ‡fl ÒËÒÚÂÏ‡: Windows, Linux

Internet Explorer 6.0

ê‡Á‡·ÓÚ˜ËÍ: Microsoft
www.microsoft.com
ìÒÎÓ‚Ëfl ‡ÒÔÓÒÚ‡ÌÂÌËfl: freeware 
éÔÂ‡ˆËÓÌÌ‡fl ÒËÒÚÂÏ‡: Windows

1 ê‡Ò¯ËÂÌÌ˚Â ÓÔˆËË ·ÂÁÓÔ‡ÒÌÓÒÚË ‚ IE
6.0 (SSL)

1 ìÔ‡‚ÎÂÌËÂ ÒÂÚËÙËÍ‡Ú‡ÏË Ë ÔÂÒÓÌ‡Î¸-
ÌÓÈ ËÌÙÓÏ‡ˆËÂÈ, ı‡Ìfl˘ÂÈÒfl ‚ IE 6.0


